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This product bears a CE marking in accor-
dance with the provisions of council directive 
93/42/EEC of June 14th, 1993 for medical 
devices.

The CE marking applies only to medico-tech-
nical products/medical products introduced in 
connection with the above mentioned com-
prehensive EC directives.

The original language of this document is 
English.
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Introduction
 
 
Welcome to the SOMATOM® CT system from 
Siemens. As a SOMATOM CT system user you 
will have access to several powerful clinical 
applications. 
The applications available on the CT system 
depend on your purchase contract.

The syngo CT Operator Manual is designed as 
a step-by-step instruction for operation of the 
system software, and its frequently used 
functions. It comprises software related 
descriptions from registration to examination 
as well as evaluation and documentation of 
your examination results.

The syngo CT Operator Manual is valid only in 
conjunction with the SOMATOM Operator 
Manual and the safety instructions contained 
therein.

This volume provides information about the 
following:

❏ Preparations

❏ Examination

❏ MPPS

❏ HeartView CT

❏ Respiratory Gating CT 

❏ CARE Bolus CT

❏ CARE Vision CT
9

 



Introduction
In this manual, the steps you perform appear 
on the right-hand side, illustrations and spe-
cial notes indicated by the bulb on the left-
hand side.

To call up system functions, only the principle 
workflow is described, although in most cases 
several alternatives are available.

Further information on basic functions are 
provided in the syngo CT Operator Manual 
Volume 1 in chapter Basics.
10

 



Introduction
To make it easier for you to work with the sys-
tem, the following documentation is included:
❏ SOMATOM Operator Manual
❏ syngo CT Operator Manual
❏ System Owner Manual

In addition to this documentation, the online 
help is supplied, but is not a permanent fea-
ture of the documentation.

SOMATOM Operator Manual

In this manual, you will find a description of 
the hardware components of the system and 
their operation. It also includes the Release 
Note.

System Owner Manual

In this manual, you will find the details and 
preconditions for operation of the CT scanner.

Online User Documentation

An online user documentation for an overview 
of general software environment, helpful 
hints, and additional information is included. 
Select Options > SOMATOM LifeNet from the 
main menu to open the SOMATOM LifeNet 
portal.

Selecting User Manuals from the navigation 
bar on the left to view the user manuals, you 
will be asked to insert the Online User Docu-
mentation CD. To view the Release Notes doc-
ument (only available in English), select View 
Release Notes. 
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Introduction
Online Help

The Online Help explains operations of the 
system’s software. It is available in English, 
German, French, Spanish, Japanese, and Chi-
nese.

Application Guides

In the Application Guides you will find clinical 
application information and suggested scan 
protocols.
12

 



Introduction
Validity of the Operator Manual

This operator manual is only valid for the 
stated software version and in conjunction 
with the latest release note.

The release note can extend the validity of the 
operator manual to following versions.

Names and Parameters

All parameters and images shown in this oper-
ator manual are examples. Only the parame-
ters displayed by your system are definite.

All names and data of patients and institutions 
that are used in this operator manual are 
entirely fictional. Any resemblance to names 
of existing people or organizations past or 
present is entirely coincidental.

Configuration-dependent designations, such 
as names of drives, network nodes, and data-
bases, that are used in this operator manual 
are usually not the same as the designations 
to be found on a particular installation of the 
system in a clinical environment.

Authorized users

The SOMATOM CT system must be used by 
persons with the necessary specialist knowl-
edge according to country-specific regula-
tions, e.g., physicians, trained radiologists or 
trained technologists, after an appropriate 
application training. If more than the fre-
quently used functions are required, the Sie-
mens customer service must be consulted.
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Preparations

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 

For example, you can enter the data in the 
morning for all the patients to be examined 
during the day. When you want to begin an 
examination, simply call up this data and edit 
it, if necessary. This saves time during the 
examinations.
14

 



Preparations
Overview

Before you can examine a patient with your 
system, you must register him or her. Regis-
tration means that you give your system all 
the information about a patient that it 
requires for an examination.

If a patient is admitted who is in an extremely 
critical condition and must therefore be exam-
ined and treated immediately, call up emer-
gency registration. This reduces the time 
before you can begin the examination to a 
minimum.

If you want to register a patient for an exami-
nation, then you first enter his or her patient 
data or select it from the database and then 
examine the patient.

If you want to prepare the system to examine 
a patient at a later point in time, then you can 
preregister the patient.

If your system is linked to, licensed and regis-
tered for an HIS/RIS system (hospital and radi-
ology information system), you can call up 
data for the patient to be examined.

When Security Package is activated, you can 
register a patient only if you are authorized to 
do so. InvokeRegistration is the privilege that 
allows you to open the registration form and 
perform registration. 
15

 



Preparations
            

         

If a current examination is not completed, a 
corresponding dialog box is displayed.

If examinations should be split into more 
studies contact your Siemens service to con-
figure the feature Study Split.

In case a patient is scheduled for more 
Requested Procedures via a RIS system and all 
procedures should be done within one exam-
ination, this feature allows to split an exami-
nation (one study) into different studies asso-
ciated to the individual Requested Procedures 
when sending it to the PACS or a different 
workstation.
16

 



Preparations
Registering a Patient

Before you can examine a patient with your 
system, you must register the patient. You can 
do that in one of the following ways:

❏ Entering the new patient with all his or her 
data

❏ Selecting known patients from the data-
base

❏ Registering an emergency patient

Registering a new patient

✧ Click on the Patient Registration icon to 
open the Patient Registration window.

Or

✧ Press the Patient Registration key on the 
symbol keypad (Num 0).

✧ Fill out the fields, which are displayed in 
boldface type.

(1) Personal data of the patient (PATIENT)

(2) Study-specific data (PROCEDURE)

(3) Referral data (HOSPITAL)

(4) Institution data (INSTITUTION)
17

 



Preparations
 

 

With the emergency button in the 
Patient Registration window you 
can start emergency registration at any time.

If you preregister a new patient (or if there is 
a HIS/RIS), you will only have to call up the 
patient data from the scheduler database 
when you perform the examination.

You can already select the required patient in 
the Patient Browser and then call up the 
Patient Registration window.

With wildcard (*), you can speed up data 
entry, e.g.:
18

 



Preparations
✧ Click on the Exam button to examine the 
patient immediately.

Or

✧ Click on the Preregister button. The 
patient information is then saved for a later 
examination.

 
 

Registering a patient from the database

✧ Click on the Patient Registration icon in 
the Patient Browser.

Or

✧ Press the Patient Registration key on the 
symbol keypad (Num 0). 

✧ Enter the patient data known to you in the 
corresponding entry fields.

✧ Click on the Search button to start a 
patient search in the databases.

✧ Select the patient from the Patient 
Search list.

✧ Accept his or her data by clicking on the OK 
button.

✧ Click on the Exam button in the Patient 
Registration window to examine the 
patient immediately.
19

 



Preparations
 

 
 

Searching a patient with multiple scheduled 
examinations in the Register platform will 
always only return the first scheduled exami-
nation.

You can change the preliminary identifiers 
after the examination in the Patient Browser 
by Edit > Correct in the main menu.

The name of an emergency patient can only 
be changed prior to sending the correspond-
ing MPPS to the RIS.

The name of an emergency patient cannot be 
changed before all raw data are recon-
structed.
20

 



Preparations
Searching an examination

✧ Select the requested examination directly 
in the scheduler.

✧ Enter the first letter of the patient’s name 
to find the requested examination.

✧ The next entry starts with this letter until 
the requested examination is found.

Emergency registration

✧ Click on the Emergency icon in the Patient 
Browser. 

✧ Enter the date of birth and sex in the Emer-
gency Registration window.

Or

✧ Skip these data with the Tab key. 

✧ Click on the Exam button.
21

 



Preparations
 
This information applies to users performing 
daily routine operations with patient data pro-
tected by the Security Package.

You need the privilege Patient Registration > 
InvokeRegistration to open the registration 
form and perform the registration.

This modification of assignment of patient 
groups is valid until the user logs off.
22

 



Preparations
Assigning Patients or 
Studies (Option)

In the Patient Registration window, you can 
modify the assignment of patient groups tem-
porarily.

Assigning new data

✧ Select Patient > Register from the main 
menu of any task card to call up the 
Patient Registration window.

Or

✧ Press the Patient Registration key on the 
symbol keypad (Num. 0).
23
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Preparations
The Patient Registration window is dis-
played.

✧ Enter the patient data into the fields, which 
are displayed in boldface type.

✧ Click on the Patient Group button.

 
 
 
 

The Select Default Patient Group window is 
displayed.

✧ Check the group you want the currently 
selected patient or study to be assigned to.

✧ Confirm your selection with OK.
25

 



Preparations
 
 
 
 
 
 

The protocols are grouped by body regions. 
Further protocols are grouped in different cat-
egories: Cardiac, Vascular, RT (Radio Ther-
apy), Specials, Private.
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Preparations
Defining Examination 
Data

Calling up the Patient Model Dialog

✧ Click on the Exam button in the Patient 
Registration window to call up the 
Patient Model Dialog.

Enter the patient’s examination data

✧ Select the set of scan protocols by checking 
Adult or Child.

✧ Select Replace or Append if you want to 
replace the last unscanned entries of the 
Chronicle or to add the selected protocol.

✧ Select Cut or Keep to add a topogram or 
not when appending a new protocol to the 
Chronicle.

✧ Select the desired scan protocol by moving 
the mouse cursor over the anatomical 
region you want to examine or to the non-
anatomical regions on the right.

✧ Click the protocol in the displayed selection 
list.

✧ Select the required patient position.

✧ Select if and how reference lines will be 
applied to all tomogram recon jobs of the 
scan.

✧ Select the desired API Language.

✧ Confirm your entries with the OK button.
27

 



Preparations
To handle and edit all changeable and visible 
parameters of scan protocols use the Scan 
Protocol Assistant by calling up Options > 
Configuration... from the main menu.

The Somaris/5 - Configuration Panel opens.

✧ Double-click on the Scan Protocol Assis-
tant icon to open the dialog window.

With the Scan Protocol Assistant, you can 
manipulate protocols, change parameters, 
import scan protocols from CD or via SOMA-
TOM LifeNet, and restore protocols to Sie-
mens default to meet different examination 
requirements.

It is not allowed to use country specific letters, 
e.g., à, ê, å, ç, ñ, etc.
28

 



Preparations
Saving scan protocols

✧ Select Edit > Save Scan Protocol from the 
main menu whenever you want to save 
scan protocols during the examination.

✧ Enter the File name, without using the 
Space key of the keyboard, but using only 
capitals, lower case letters, numeric char-
acters, and the underscore for file naming, 
as follows:
❏ Numbers:  

0123456789
❏ Capitals: 

ABCDEFGHIJKLMNOPQRSTUVWXYZ
❏ Lower case letters: 

abcdefghijklmnopqrstuvwxyz
❏ Special characters:  

_
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Preparations
Automatic functions

Your system provides several automatic func-
tions for routine examinations:

❏ Automatic processing of consecutive 
acquisitions (Auto Range).  
Auto ranges are marked by brackets in the 
chronicle.

❏ Automatic Field of View (Auto FoV). 
When you adapt scan ranges, they can also 
be auto adapted according to the patient’s 
body. The left and right border of the FoV 
cover both sides of the body.

❏ Full reconstruction of the images in parallel 
with the examination.  
This automatic function is activated for 
sequence scans.
31

 



Preparations
 
 
 
 

When API is switched on and Automatic clus-
tering is activated on the Scan subtask card, 
sequence scans are automatically clustered, 
according to the breathhold time which was 
entered in the Examination Configuration 
dialog window.
32

 



Preparations
❏ Time-saving reconstruction of the images 
simultaneous with scanning (RTD).  
Or real time reconstruction with full image 
quality depending on the scan and recon-
struction parameter (RTR). 
This automatic function is activated for spi-
ral scans.

❏ Automatic patient instruction system 
(API). 
This function is active if a desired API Lan-
guage is selected on the Patient Model 
Dialog, an announcement text is selected 
on the Scan card, and the API icon is 
switched on. 

❏ Automatic archiving and sending of all 
images after reconstruction of the series.

❏ Automatic transferring of images and data 
to other applications for each Recon job 
(Auto Tasking subtask card).
33

 



Preparations
 
If Study Split is activated, when you change 
the Requested Procedure of one recon job, 
all following unprocessed recon jobs with the 
same preset Requested Procedure descrip-
tion will be updated automatically.

If you want to transfer the series data to the 
network via FTP during the reconstruction, 
please contact your Siemens service to config-
ure. 

Memos and contrast medium pauses are 
inserted in the chronicle analogously.
34

 



Preparations
(1) Recon job and Series description for Auto 
Tasking definition

(2) Settings for automatic Filming

(3) Settings for automatic data transfer

(4) Automatic loading into Viewing

(5) Auto postprocessing functions

(6) Requested procedure and Body part 
examined

Inserting a control scan

✧ Select the step of your scan protocol which 
shall be preceded by a control scan, e.g., 
spiral and sequence scan.

✧ Call up the context menu of the 
chronicle (right mouse button).

✧ Select Control Scan with the left 
mouse button.

Now a control scan is included in the chroni-
cle.
35

 



Preparations
If you want to append the examination step at 
the end of the scan protocol, no entry should 
be selected in the chronicle.
36

 



Preparations
Deleting an examination step

✧ Select the step in the chronicle and 
call up the context menu.

✧ Click on Cut. 
The selected examination step is 
deleted from the chronicle.

 
 
 

Moving an examination step

✧ Cut the step that you want to move.

✧ Select the step in the chronicle which shall 
be preceded by the step you have just cut.

✧ Call up the context menu. 

✧ Select Paste.
37
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Preparations
Copying an examination step

✧ Select the step that you want to 
copy and call up the context menu 
of the chronicle.

✧ Click on Copy. 

✧ Select the step in the chronicle which shall 
be preceded by the step you have just cop-
ied.

✧ Insert the examination step with 
Paste (context menu).

Repeating an examination step

✧ Select the step in the chronicle that 
you want to repeat and call up the 
context menu of the chronicle.

✧ Click on Repeat. 

In the chronicle, the same examination step is 
inserted after the selected step.
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Preparations
Positioning the Patient

 
 

✧ Lower the patient table until the patient 
can easily sit down or be placed on it.

✧ Use any positioning accessories which 
might be necessary.

✧ Position the patient as appropriate for the 
planned examination.

Examples:

❏ Sinus (direct coronal slices) 
The chin of the patient is placed in the rigid 
head holder or the optional coronal prone 
head holder. 
The head is tilted backward as far as possi-
ble.

❏ Lumbar vertebrae 
The patient is supine with the arms crossed 
above the head on the head/arm rest, with 
a support under his knees. 

❏ Abdomen 
The patient is supine with the arms crossed 
above the head on the head/arm rest. 
 
(1) Pancreas (beginning at the sternum) 
(2) Pelvis (beginning at the pelvic crest)
41

 



Preparations
 

The table height must always be set in such a 
way that the region of interest is in the center 
of the scan field. Maximum gantry tilting is 
possible as long as the table height ranges 
between 95 mm and 105 mm.

The predefined table positions can be config-
ured by the Siemens Service technicians.

The button will be active as long as it is 
pressed.
42

 



Preparations
✧ Tilt the gantry from vertical position. 
 

✧ Switch the laser light marker on and off. 
 

✧ Adjust the table height.

✧ Move the table into and out of the gantry. 

✧ Move the table to two predefined posi-
tions. 

✧ Move the table top out of the gantry open-
ing and lower it.
43

 



Examination

For clinical application information and sug-
gested scan protocols see Application 
Guides.
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Examination
Acquiring a Topogram

Checking the topogram parameters

✧ Select the topogram acquisition in 
the chronicle of the Examination 
card.

✧ Check the topogram parameters set on the 
Routine subtask card.

(1) Topogram length in mm

(2) Tube position

(3) Table position and height

(4) Patient position

(5) Scan direction

✧ Correct the Topogram length, Tube posi-
tion, and scan direction, if necessary.
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Examination
 

The START key may only be enabled when the 
door of the examination room is closed.

The topogram is displayed in real 
time. You can stop the scan with the 
Suspend button as soon as enough 
data is acquired.
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Examination
Starting the topogram scan

✧ Click on the Load button to confirm the 
scan parameters. 

 ✧ Press the START key on the control box.  
 

The topogram is displayed in the left upper 
segment of the Examination card. 

The examination ranges of the subsequent 
scans is displayed in pink color.
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Examination
We recommend you choose a slightly larger 
FoV for the control scan than for the following 
scans. This will make it easier for you to adjust 
the FoV for the spiral or sequence scans. 

For the control scan, to apply the changes to 
the following ranges with the same FoV and 
the same center position, release the mouse 
button. Not to apply the changes to the fol-
lowing ranges with the same FoV and the 
same center position, use the Shift key.
48

 



Examination
Adapting ranges

✧ Select the entry that you want to edit in the 
chronicle.

✧ Move the range or the cutlines by 
dragging the center.

✧ Change the length of the range by 
dragging one of the handles 
(upper/lower handle) or the FoV of 
the range (side handles).

✧ Set the gantry tilt by grabbing and 
tilting a corner of the range in a lat-
eral topogram (tilt is recom-
mended for sequence scans only).

✧ If nacessary, hold the Ctrl key down to 
switch on the Auto FoV function when you 
adapt the scan ranges.
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Examination
 

The parameters of the subsequent scan are 
used for the control scan, but you can change 
the starting position in the topogram.

The orange line represents the position of the 
currently displayed tomo image. 

You can zoom the tomogram of the 
control scan with the mouse so that 
you can adjust the FoVs more easily.
50

 



Examination
Performing a Control 
Scan

✧ Click on the Load button to confirm the 
preset scan parameters.

 ✧ Press the MOVE key on the control box 
until the table movement stops.

Or

✧ Click on the Cancel Move button for a scan 
at the current table position or current 
gantry tilt.

 ✧ Press the START key on the control box.

Adapting FoV of the subsequent range

✧ Select the reconstruction target using the 
Recon icon in the chronicle.

✧ Check in the topo segment 
whether the position of the FoV in 
the tomogram is correct. If not, 
move the center.

✧ Change the size of the FoV with the 
handles, if necessary.
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Examination
It is strongly recommended to see the opera-
tor manual of your injector for further infor-
mation on scanning in Injector coupled 
mode.

Following scan types are not supported:
❏ Topogram
❏ Biopsy mode
❏ Bolus pre-monitoring
❏ CARE Vision CT

By selecting Edit > Save Scan Protocol from 
the main menu, you can save scan protocols 
with Injector coupled as predefined scan 
start.

Via Options > Configuration... > Somaris/5 - 
Configuration Panel > Scan Protocol Assis-
tant you can predefine the Injector coupled 
mode for your contrast enhanced scan proto-
cols.
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Examination
CARE Contrast CT 
(Option)

If your CT scanner is connected to an injector, 
synchronized communication allows the 
operator to start and to stop scanning either 
via CT scanner or via injector.

Scanning in Injector coupled mode

✧ Select the Scan subtask card.

✧ Select Injector coupled (Start button) or 
Injector coupled (Foot switch) from the 
Scan start selection list.
53

 



Examination
  

As CT scanner and injector are started simul-
taneously the scan delay time has to be 
adjusted.

In case the injector is not yet ready for scan-
ning a yellow message bubble is displayed 
that prompts you to check the injector. 
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Examination
Checking parameter settings

✧ Check the default scan parameters on the 
Routine card and correct them if neces-
sary.

→ Page 59, Checking parameter settings

✧ Enter the required scan delay time into the 
Delay entry field.

Performing a scan in Injector coupled 
mode

✧ Click on the Load button to confirm the 
scan parameters.

 ✧ Press the MOVE key on the control box 
until table movement stops.

Or

✧ Click on the Cancel Move button to start 
the sequence or the spiral scan at the cur-
rent table position and gantry tilt.

✧ Prepare (arm, enable) the injector follow-
ing the operator manual of the injector.
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Examination
 
 
 
 

The yellow message bubble Press Start indi-
cates that both systems are ready for scan-
ning. 

The Injecor coupled scanning start condition 
is reset to uncoupled in case:
❏ You perform an additional or a control scan
❏ You paste or repeat a coupled range

See the operator manual of your  injector for 
further information on requesting a CT scan-
ner stop remotely. 
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Examination
 ✧ Press the START key on the control box of 
the CT scanner to start both systems.

Or

✧ Press the START key on the injector to start 
both systems.

 
 
 
 
 
 
 
 
 
 
 
 

Canceling a scan in coupled mode

 ✧ Press the STOP key on the control box to 
stop both systems.

Or

✧ Press the STOP key of the injector to stop 
both systems.

Radiation and injection of contrast medium is 
stopped immediately and the entire system is 
blocked. 
57

 



Examination
The Scan subtask card contains further 
parameter settings.
58

 



Examination
Acquiring a Sequence

Checking parameter settings

✧ Check the default scan parameters on the 
Routine card and correct them if neces-
sary.

(1) Radiation parameters

(2) Time settings

(3) Slice thickness

(4) Number of scans and images

(5) Gantry tilt

(6) Comment lines

(7) Examination range

(8) Examination direction

(9) Table position (horizontal/vertical)
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Examination
 

With CARE Dose 4D, the system automati-
cally calculates optimized scan parameters 
from attenuation data of the topogram.

With CARE Dose 4D activated as default, the 
Image Quality Reference mAs value is set to 
the default value of the protocol.

After deactivating CARE Dose 4D the Image 
Quality Reference mAs is dimmed and the 
(eff.) mAs value has to be adjusted to the indi-
vidual patient size. 

If CARE Dose 4D is switched on again, the 
Image Quality Reference mAs is reactivated.
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Examination
Activating and deactivating CARE Dose 4D 

✧ Select the Scan subtask card.

 

✧ Activate or deactivate the CARE Dose 4D 
checkbox for the current scan.

 
 
 
 
 
 
 
 
 
 
 
 
 

Special parameter setting

✧ For a sequential scan with gaps (e.g., high-
resolution pulmonary examination), 
increase the table feed on the Scan sub-
task card.
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Examination
After you have changed scan parameters you 
must confirm the new settings with Load 
before starting the scan.

If the sequence is part of an auto range and 
not all ranges have been selected at least 
once, a parameter overview is displayed. You 
can display this overview manually with 
View > Examination Overview....

If you have selected Injector coupled mode 
as starting condition for scanning, the yellow 
message bubble Press Start indicates the 
simultaneous start of CT scanner and injector.

→ Page 53, Scanning in Injector coupled 
mode
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Examination
Performing a sequence scan

✧ Confirm the scan parameters with the 
Load button. 
 

 ✧ Press the MOVE key on the control box 
until table movement stops.

Or

✧ Click on the Cancel Move button to begin 
the sequence at the current table position 
and gantry tilt.

 ✧ Press the START key on the control box.
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Examination
You can interrupt the scan at any time with 
the Suspend button or the HOLD key on the 
control box.
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Examination
You can observe the progress of the sequence 
on the screen and intervene if errors occur 
(e.g., with the Suspend button).

❏ In the chronicle you can see the number of 
scans already acquired and the total num-
ber of scans to be performed.

❏ The current scan position is displayed in 
the topogram.

❏ In the tomo segment, the calculated tomo-
grams are displayed.

Cancellation in an emergency

 ✧ In an emergency situation, press the STOP 
key on the control box.

Radiation is stopped immediately and the 
entire system is blocked. 

You then have to enable the system again 
with Continue.
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Examination
Prior to scanning you select the desired oper-
ation mode CARE Dose or CARE Dose 4D in 
the Scan Protocol Assistant.

Make sure that the corresponding scan is 
selected in the chronicle.

The Scan subtask card contains further 
parameter settings.
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Examination
Acquiring a Spiral

Checking parameter settings

✧ Check the default scan parameters on the 
Routine card and correct them if neces-
sary.

(1) Radiation parameters

(2) Time settings

(3) Slice width

(4) Number of images in the first reconstruc-
tion job (not available for Sensation Car-
diac and Sensation 16)

(5) Gantry tilt

(6) Comment lines

(7) Scan range

(8) Scan direction

(9) Table position (horizontal/vertical)
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Examination
With CARE Dose 4D, the system automati-
cally calculates optimized scan parameters 
from attenuation data of the topogram.

With CARE Dose 4D activated as default, the 
Image Quality Reference mAs value is set to 
the default value of the protocol.

After deactivating CARE Dose 4D the Image 
Quality Reference mAs is dimmed and the 
(eff.) mAs value has to be adjusted to the indi-
vidual patient size. 

If CARE Dose 4D is switched on again, the 
Image Quality Reference mAs is reactivated.
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Activating and deactivating CARE Dose 4D 

✧ Select the Scan subtask card.

 

✧ Activate or deactivate the CARE Dose 4D 
checkbox for the current scan.
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Examination
After you have changed scan parameters, you 
must confirm the new settings with Load 
before starting the scan.

If the spiral is part of an auto range and not all 
ranges have been selected at least once, a 
parameter overview is displayed. You can dis-
play this overview manually with View > 
Examination Overview....

If you have selected Injector coupled mode 
as starting condition for scanning, the yellow 
message bubble Press Start indicates the 
simultaneous start of CT scanner and injector.

→ Page 53, Scanning in Injector coupled 
mode
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Examination
Performing spiral acquisition

✧ Confirm the scan parameters with the 
Load button. 
 

 ✧ Press the MOVE key on the control box 
until the table movement stops.

Or

✧ Click on the Cancel Move button to start 
the spiral at the current table position and 
gantry tilt.

 

 Press the START key on the control box.
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Examination
RTR (real time reconstruction) images 
are calculated with full image quality.

RTD (real time display) images are cal-
culated with reduced image quality.

You can interrupt the scan at any time with 
the Suspend button or the HOLD key on the 
control box.
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Examination
You can observe the progress of your scan on 
the screen so that you can intervene immedi-
ately if problems arise (e.g., with Suspend).

❏ In the chronicle you can see the remaining 
scan time.

❏ The current scan position is displayed in 
the topogram.

 
 
 

Cancellation in an emergency

 ✧ In an emergency situation, press the STOP 
key on the control box.

Radiation is stopped immediately and the 
entire system is blocked. 

✧ You must then enable the system again 
with Continue.
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Examination
With Add Scan in the context menu 
you can perform an additional scan if 
the range was planned too short.
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At the end of scanning

 ✧ Use the MOVE key to move to the starting 
position of the next range.

✧ Begin with the next scan. 
→ Page 69, Activating and deactivating 
CARE Dose 4D

Or

✧ Reconstruct the scan series with full image 
quality. Conclude the examination by cre-
ating a topographic image. 
→ Page 87, Reconstruction 
→ Page 105, Concluding an Examination
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Examination
 
 
 
 
 

 

Biopsy mode cannot be performed for scans 
with auto range, nor for HeartView CT, or for 
CARE Bolus examinations.

Individual scans are always acquired at the 
current table position with a slight start delay.
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Examination
Biopsy CARE View 
(Option)

Biopsy Mode

Biopsy mode is provided for CT guided biop-
sies. The examining physician can trigger indi-
vidual scans in the examination room at any 
table position. The individual tomogram 
scans can be observed on a second monitor 
located in the examination room. 

A detailed representation of the organ struc-
tures in the tomogram allows a precise local-
ization of the lesion and the surrounding 
region. The physician can therefore plan the 
path of the puncture in the transversal cut 
precisely, avoiding critical structures such as 
vessels, nerves, or the intestine.
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Examination
 
 

Slice thicknesses suitable for the biopsy CARE 
View display mode are displayed in boldface 
type on the Routine subtask card under Silce.
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Examination
Preparing Biopsy

✧ Locate the structure to be punctured with a 
spiral scan.

✧ Mark the path of access and the point of 
insertion on the skin surface.

✧ Select the biopsy scan protocol from the 
Specials scan protocol list in the Patient 
Model Dialog.

Or

✧ For regular sequence scans, click the 
Biopsy Mode icon on the Routine subtask 
card.

Biopsy CARE View Display (Option)

✧ Check parameter settings and ensure that 
the number of slice position per scan is 
three.

✧ Confirm the scan parameters with the 
Load button.
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Examination
(4)

(3)

(2)

(1)

The display order of three segments can be set 
on the Recon subtask card

Click on the dogear on the biopsy center seg-
ment to scroll between the previous or next 
three images.

Double-click on any of the Biopsy CARE View 
segments to toggle between the normal 
image display and the image display in full 
screen size.

After the scanning is finished or suspended, 
the three segment display mode will change 
back to the normal two segment display mode 
with a topo and a tomo segment.
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Examination
The biopsy CARE View segments are displayed 
automatically.

(1) Biopsy left segment (left bottom).

(2) Biopsy center segment (top middle).

(3) Biopsy right segment (right bottom).

(4) Intervention toolbar. 
→ Page 175, Using the Intervention Tool-
bar

Use the intervention toolbar to change the 
image display mode.

✧ Click on the Blow Up icon to display images 
in the blow up mode (one image has the 
size of the complete image area).

✧ Click on the Two Segments icon to display 
images in the topo and the tomo segment.

✧ Click on the CARE View icon to display 
images in the CARE View mode (three seg-
ements have the same size).
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Examination
 

Patient protocols are not displayed on the 
Examination task card, but like any image 
they can be displayed on the Viewing task 
card, filmed, and sent etc., from the Patient 
Browser.

Patient protocols are automatically created by 
the system at the end of an examination and 
cannot be modified by the user.

Automatic creation of patient protocols is set 
in the Examination Configuration dialog.

The function Auto filming works on patient 
protocols as well.
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Examination
Patient Protocol

A patient protocol summarizes examination 
data and can therefore be used to document 
examinations, for example, in case the fea-
ture MPPS (Modality Performed Procedure 
Step) is not available at your CT SOMATOM 
scanner. 

A patient protocol contains the following 
information: 

❏ Patient data, like name and ID 

❏ Administrative data, like referring physi-
cian and ward

❏ Examination scan data, like patient posi-
tion and total mAs

❏ Contrast data, like media quantity and 
injection parameters

❏ Scan protocol data, like type and gantry tilt 
for each scan

❏ Dose parameters, like CTDIvol and DLP, total 
DLP
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Examination
For the scan modes Sequence and CARE 
Vision, the displayed scan number indicates 
the beginning of a scan range.

The other values displayed in one row are 
valid for all scans of this scan range, i.e. for all 
single scans, or specify the average of these 
parameters (dose and mAs) for the scan 
series.
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Examination
Total DLP DLP value of the entire examination

Total mAs actual mAs value of the entire 
examination

Scan: number of scan ranges

kV: tube voltage (kilo Volt)

mAs: averaged applied mAs of the range

ref. mAs quality ref. mAs of the range

CTDIvol  
(Volume 
Computed 
Tomography 
Dose Index):

average applied dose in mGy (milliGray)

DLP  
(Dose Length 
Product):

Dose Length Product

TI: Rotation Time

cSL: collimated Slice

CTDIW

Pitch Factor

CTDIvol x (length + collimated slice)
10
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Examination
 
If a scan protocol is loaded, the background, 
recon jobs are stopped immediately.

When the system is switched off, the jobs are 
stopped and their current state is saved. After 
restart the execution of the reconstruction 
jobs continues.

Zooming and moving the FoV before starting 
the reconstruction leads to an appropriate 
spatial resolution for the resulting recon-
structed image.

For sequence scans, Full Image Quality mode 
can be used.

For spiral scans, RTD(Real-Time Display) mode 
and RTR (Real-Time Reconstruction) mode can 
be used.

With Add Scan in the context menu 
you can perform an additional scan if 
the range was planned too short.

If all reconstruction jobs have been com-
pleted, you must create new jobs for further 
calculations. 
→ Page 101, Creating new reconstruction jobs
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Examination
Reconstruction

Checking reconstruction parameters

✧ Select an open recon icon in the chronicle 
for processing.

✧ Check the default parameters on the 
Recon subtask card and correct them if 
necessary.
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Examination
 

 

The Overview button will be dimmed until 
the scan job is finished.

An overview image is only necessary if you 
want to enlarge the FoV beyond the edge of 
the image for the reconstruction.
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Examination
(1) Selected reconstruction job and Series 
description

(2) Reconstructed slice thickness
(3) Kernel
(4) Organ-specific window
(5) FoV coordinates
(6) Recon job type (spiral only)
(7) Table position for the first image
(8) Image Order
(9) Reconstruction increment (spiral only)
(10)Number of images
(11)Recon specific image comment

Creating an overview image

✧ Click on the Overview button on the 
Recon card.
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Examination
When modifying the size of the scan range an 
orange line representing the position of cur-
rently displayed tomo image moves, display-
ing interactively the corresponding tomo 
image.
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Examination
Defining the reconstruction target

✧ Adapt the FoV (Field of View) in the 
tomo segment to the region of 
interest with the mouse. 
→ Page 51, Adapting FoV of the subse-
quent range
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Examination
Each 3D segment shows one plane of the 
image volume (default: coronal, axial, sagittal 
from left to right).  
The coordinate axes are perpendicular to each 
other and the angles between the axes can-
not be changed.
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Examination
Workflow of a 3D recon job (Option)

The 3D recon jobs can be started on the 
Examination task card and on the Recon task 
card directly after spiral scanning. The axial 
images created during scanning are used as a 
planning base (3D GRP base).

✧ Scan a protocol, reconstruct raw data axi-
ally.

✧ Select 3D as recon job type in the Recon 
subtask card.

The three 3D segments (coronal, axial, sagit-
tal) are displayed instead of the standard 
tomo segment and topo segment.

✧ Optimize the image display by interacting 
in the three segments.

✧ Click on the Recon button to start recon-
struction.

The system returns to the standard display if 
you start the reconstruction of the 3D recon 
job and the reconstructed images are dis-
played in the tomo segment.
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Examination
Image series requirements for the 3D GRP 
Base are:

❏ The series is reconstructed axially from the 
raw data of this scan range

❏ Extended FoV is off

❏ Center X, Center Y and FoV are the same 
for all images of the series
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Optimizing the image display

✧ Select a segment.

✧ Choose the required icon from the tool bar 
on the Examination or on the Recon task 
card.

✧ Click on the Set FoV Segment icon if you 
want to define the active 3D segment as 
new FoV segment.

✧ Click on the Set Reference Segment icon 
if you want to define the active segment as 
new segment or the reference images.  
Zoom, pan and window the images.

✧ Click on the Free Mode icon if you want to 
rotate the axes in any segment. 

✧ Click on the Default Orientation icon if 
you want to set the orientation of the 3D 
segment to its defaults (axial, feet to 
head).

✧ Click on the Hide Reference Lines icon if 
you want to suppress the cutlines in the 3D 
segments.
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Examination
✧ Click on the MPR Thick and MIP Thin icons 
if you want to select the image type for the 
current and future 3D GRP Base.

✧ Click on the Preview Image icon if you 
want to check whether the reconstruction 
parameters you set are suitable.

✧ Select an existing 3D GRP Base from the 
Planning base selection list for the current 
and the following 3D recon jobs.

✧ Select Matrix Size to define whether the 
FoV mode is square or non-square.
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Examination
 
Except for 3D Recon jobs (to be initiated 
explicitly), all open reconstruction jobs are 
executed if none of the previous ranges have 
been selected.
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Examination
Starting reconstruction

✧ Click on the Recon button to start recon-
struction of the currently selected acquisi-
tion series.

In the tomo segment, all the images calcu-
lated are displayed one after the other.  
The bar display on the right-hand edge indi-
cates the progress of reconstruction.

Interrupting and resuming reconstruction

✧ Click on the Hold Recon button, e.g., to 
correct the FoV. 

✧ Click on the Recon button to resume 
reconstruction.
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Examination
 

 
 

 
 
 

If there are already recon jobs, click on the 
next free radio button for a new job or first 
delete old recon jobs. 

Copying and replacing the reconstruction is 
only possible from a 2D to a 2D and from a 3D 
to a 3D recon job.
100

 



Examination
Creating new reconstruction jobs

✧ Select the acquisition series that you want 
to reconstruct again in the chronicle.

✧ Click on the second radio button on the 
Recon subtask card to plan a second recon 
job.

Copying and replacing reconstruction 
range

✧ Click on the Reconstruction icon in the 
scan protocol entry (spiral only).

✧ Call up the recon job context menu 
(right mouse button).

✧ Click on Copy Recon Range.

 
The parameters of this recon job are copied to 
the clipboard to replace the reconstruction 
volume parameters of another recon job.

✧ Click on the Reconstruction icon in the 
designated scan protocol entry.

✧ Click on Replace Recon Range.
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Examination
If you delete a completely or partially exe-
cuted recon job, the images created with it 
are not deleted. It is only possible to delete 
images in the Patient Browser.

On the Auto Tasking subtask card, you define 
in which way a reconstructed series is auto-
matically post-processed. Depending on the 
type of scan, not all options may be available.

Auto Tasking parameters are set individually 
for each recon job.
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Deleting reconstruction jobs

✧ Select a recon job in the chronicle.

✧ Select Delete Recon Job in the context 
menu of the chronicle.

Asynchronous 
Reconstruction

Reconstruction can be executed in the back-
ground without blocking the Examination 
task card or the Reconstruction task card.

You can:

❏ Plan a reconstruction job while another job 
is already being reconstructed

❏ Start several reconstructions simulta-
neously

❏ Control the reconstruction queue and 
other postprocessing jobs

❏ Handle at least 100 examination jobs.
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Examination
You can create Auto reference lines for a 
specific tomogram recon job by activating the 
checkbox on the Auto Tasking subtask card.
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Examination
Examination Job Status

✧ Select Patient > Examination Job Status 
from the main menu to display the Exami-
nation Job Status window. 

Concluding an 
Examination

Examination overview (Reference Lines)

✧ Select a topogram in the chronicle.

✧ Select the recon icon of a reconstructed 
series in the chronicle.

✧ Drag the recon icon to the topo segment 
and drop it onto the topogram.

The images of the recon job are drawn in and 
saved as cutlines or ranges in the topogram.
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Examination
 

The raw data is saved automatically.

If all recon jobs are closed, a dialog box for 
deleting raw data is displayed when End 
Exam is executed.

Raw data have to be deleted manually. 

✧ Check the storage capacity symbol on the 
status bar regularly for the raw data mem-
ory.

If Study Split is activated and you send the 
examination to another workstation, or a 
PACS, the study can be split into different 
studies. The single studies are associated to 
the individual Requested Procedures (e.g. 
Accession No.). Each study contains:
❏ The series, which is assigned to the 

Requested Procedure 
❏ One copy of the topogram

The study cannot be continued if:
❏ The study is currently being processed on 

the syngo CT Workplace
❏ The scan protocol for this study is not 

available
❏ The license for the study is missing (e.g., 

Cardio)
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Ending the examination

✧ Click on the Close current patient icon.

The E-Logbook input window opens in the 
subtask card area.

✧ Modify the desired fields in the E-Logbook 
input window.

✧ Click OK to save the changes and to end 
the examination.

Continuing an examination

You can continue the examination after clos-
ing the patient.

✧ Select a study in the Patient Browser and 
open the Patient Registration to register 
the patient for scanning by selecting 
Patient > Register from the menu.

Or

✧ Select an additional scheduled procedure 
step from the Scheduler.

The entry Exam Continue [patient position] 
is displayed in the Chronicle and the exami-
nation can be continued.
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Examination
Reconstruction on the 
syngo CT Workplace 
(Satellite Console)

The syngo CT Workplace is the primary site for 
image viewing, filming, exporting data, 3D 
reconstruction, and data postprocessing. To 
have access to the raw data it has to be con-
nected with the syngo Acquisition Workplace.  
It supports the syngo Acquisition Workplace 
which mainly controls the data acquisition of 
the scanner. 

At the same time, undisturbed further patient 
data evaluation is possible on the virtually 
independent syngo CT Workplace.

✧ To start an additional reconstruction load 
the required raw data into the Recon task 
card. 

The workflow on the syngo CT Workplace is 
identical to the one on the syngo Acquisition 
Workplace.
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The MPPS function is protected by license.  
If this license is not available, only local MPPS 
management is possible, and no feedback will 
be sent to the HIS.

The CT system generates entries automati-
cally in the MPPS, e.g., applied dose, gener-
ated series and consumed contrast media. 
You can also add information manually (e.g., 
contrast medium with flow, volume, kind of 
contrast medium).

A MPPS is typically created as a part of the 
patient registration process in which 
❏ either the HIS/RIS requests a worklist 

procedure, or
❏ a locally created procedure (such as for an 

emergency patient) is prepared for 
acquisition.

In case you cannot edit the MPPS information, 
you do not have appropriate access rights. 
Security in syngo ensures that access to func-
tions and data is always provided in accor-
dance with the privileges and permissions 
granted to a user.
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MPPS
Overview

The exchange of information based on 
Modality Performed Procedure Step (MPPS) 
closes the gap between the modalities and 
the HIS/RIS. The information documents the 
actions being performed for a patient.

During an examination, the modality sends a 
message indicating the start and the end of 
the examination. As a result the status of the 
examination can be called up at any time. 

The MPPS component mainly handles the fol-
lowing: 

❏ Creating MPPS during patient examination 

❏ Passing information to the HIS/RIS 

❏ Updating the MPPS status to the HIS/RIS 
based on user interaction and automatic 
procedures 

Thus a smooth clinical flow is ensured, and 
billing, dosage, and other information is gen-
erated within the hospital system. 

Following helpful features for integrating the 
modalities with the supervising information 
system in the hospital are provided:

❏ Displaying the patient information for 
MPPS

❏ Viewing the action items for MPPS

❏ Viewing the dose information for MPPS

❏ Viewing the billing information for MPPS
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MPPS
The availability of buttons depends on the sta-
tus of the MPPS.
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MPPS
Controlling the MPPS

Layout of the MPPS dialog box

The Modality Performed Procedure Step 
dialog box consists of three areas.

(1) Patient and Study areas
❏ Patient data 
❏ Study description

(2) Upper part of the MPPS area 
❏ Data of the selected MPPS
❏ Input field for comments to the MPPS 

(3) Lower part of the MPPS area 
❏ Examination data sorted by various 

aspects and displayed in three tab cards 
(not all of them may be available at your 
modality)
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MPPS
In the Patient Browser, the MPPS series are 
marked by the following flags:

❏ IN PROGRESS: series refers to MPPS which 
is in Progress

❏ DISCONTINUED: series refers to MPPS 
which is Discontinued

❏ HIS or LOC: series belongs to an 
examination planned by RIS or locally

❏ se: MPPS message acknowledged by IS

Before you conclude your work on the exami-
nation by archiving, check and add missing 
entries to the performance report.

The usage of the DICOM service MPPS 
depends on the availability of the correspond-
ing RIS system.  
Even if no RIS with MPPS service is connected, 
the MPPS icon is displayed in the Patient 
Browser. This item has to be ignored. (Only if 
Study Split is activated).
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MPPS
Opening the MPPS dialog box

✧ Select the patient, the examination, or one 
of the associated series or images from the 
Patient Browser.

✧ Click on the Show MPPS icon in the tool 
bar of the Patient Browser.

The Modality Performed Procedure Step 
dialog box is displayed.
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MPPS
This does not complete the examination.  
No message is sent to the HIS/RIS.

If you consider further steps, you can at first 
save the document, and close it later.

If you close the patient, the MPPS will be 
closed automatically. Thus no modification 
for MPPS is possible thereafter.

The MPPS is closed. A corresponding message 
is forwarded to the HIS/RIS.

The Send button is displayed only, if a MPPS 
node is configured.

Every time you click one of the buttons 
Completed, Discontinued or Send in the 
Modality Performed Procedure Step dialog 
box, information about status and changes of 
the MPPS is sent to the HIS/RIS.
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MPPS
Saving an MPPS

✧ Click the button Save to save your changes 
of the document. 

Finishing an MPPS 

✧ Click the button Completed to close the 
MPPS dialog box when all data shown in 
the performance document are correct, 
and complete the examination. 

Aborting an MPPS

✧ Click the button Discontinued if the exam-
ination is not to be continued, or if it is can-
celed. 

 

Sending Information back to HIS/RIS

✧ Click the button Send to mark the MPPS as 
being processed and to inform the HIS/RIS 
about changes in the MPPS.

Closing the MPPS dialog box without any 
changes

✧ Click the button Cancel to close the dialog 
box if you only have opened the document 
for printing or viewing.
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MPPS
 
 
 
 
 

In the status bar of any task card you can eas-
ily supervise whether the message was suc-
cessfully sent from MPPS to HIS/RIS.

In case of an error, a message appears.  
Please, also check the status bar at the bottom 
of the task card for any error information.
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MPPS
Checking the MPPS Information 

✧ Click in the center of the status bar of the 
task card to check the corresponding entry 
in the History of Events.

A list of events is displayed.

✧ Look for an entry in the list concerning the 
MPPS. 

If you do not find such an entry, it is already 
removed, because the information was sent 
successfully to the HIS/RIS.

✧ If you find an entry concerning the MPPS, 
click it.
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HeartView CT

For clinical application information and sug-
gested scan protocols see Application 
Guides.
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HeartView CT
Overview

The beating of the heart makes it difficult to 
capture static images, which would make it 
easier to diagnose cardiac diseases. 

The advanced HeartView CT option uses an 
ECG as a trigger for capturing images at the 
same heart phase. This reduces or even sup-
presses motion artifacts. 

The image data is synchronized to the heart 
cycle (i.e., to the motion of the heart). To 
achieve this, two methods are available, 
which belong to the mode of data acquisition:

❏ For sequences, prospective triggering is 
employed. The ECG signal is used to trigger 
a CT scan at the appropriate heart phase 
(with a certain delay after the R-wave).

❏ For spirals the ECG and the CT raw data are 
recorded simultaneously. Then retrospec-
tive gating selects only a portion of the spi-
ral data to reconstruct images of the 
selected heart phase.
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HeartView CT
    

If you register the patient for Heart View 
examination and the ECG electrodes have not 
been connected yet, a corresponding dialog 
box is displayed.

✧ Connect the ECG electrodes and then click 
on the Try again button.

For scans with contrast agent you should 
always activate the synthetic trigger so that a 
scan does not have to be stopped if problems 
arise with the ECG signal. 
→ Page 125, Setting gating parameters 
→ Page 129, Setting trigger parameters
122

 



HeartView CT
Preparations

In addition to the usual preparations in the 
examination room and on the console, some 
actions specific to HeartView CT are required. 

✧ Position the patient on the patient table 
and immobilize the patient using the posi-
tioning accessories, if necessary.

✧ Apply the electrodes for the electrocardio-
gram (ECG) and connect the ECG cable to 
the socket at the head end of the table.

✧ In the Patient Model Dialog select the 
required Cardiac scan protocol and regis-
ter the patient for examination. 

✧ Scan a topogram and define the ranges for 
the spiral or sequence.

✧ Prepare for scanning with contrast agents, 
if applicable.
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HeartView CT
  

 

The Scan time and the Pitch on the Scan sub-
task card cannot be modified.

A positive value (Unit: %) in the Phase Start 
field means a delay after the R wave.  
A negative value (Unit: %) means that the 
starting point of the scan window is before 
the next estimated R wave.

Only data acquired in the scan window can be 
reconstructed with high image quality if ECG 
Pulsing is activated.

Using the CARE Bolus option you can syn-
chronize an ECG-gated spiral with administra-
tion of the contrast medium.

With a control scan you can check the set scan 
parameters and the trigger parameters of the 
spiral.  
The control scan is performed like an ECG-trig-
gered sequence.
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HeartView CT
ECG Gated Spiral

Setting scan parameters

✧ On the Routine and the Scan subtask card, 
check the scan parameters preset in the 
scan protocol and change them if neces-
sary.

Setting gating parameters

✧ For examinations with contrast agents in 
particular, activate Synthetic Sync.

✧ Select ms (absolute delay) or % (relative 
delay) as the trigger unit in the selection 
box on the Trigger card. 

✧ Set the recon delay in the spin box in the 
Phase Start field.  

✧ Click on the checkbox ECG Pulsing to acti-
vate dose modulation (an enhanced algo-
rithm especially for irregular cycles) for 
reducing dose during scanning. 
 
 
 
 

Acquiring the spiral

✧ Perform the spiral acquisition in the usual 
way. 
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HeartView CT
 

The ECG curve now contains a scroll bar via 
which you can call up the ECG progression. In 
that way you can optimize the position of the 
scan window for the entire spiral acquisition.

With Original ECG you can switch between 
the original and the modified ECG signal and 
back (ECG editing).

By right-clicking on the Multiphase 
icon you can set up start delay, end 
delay and the increment between 
start and end delay in the Heart-
View Configuration dialog box (Multiphase 
tab card).

With the Preview Series icon you 
can reconstruct images at a scan 
position with different delays to 
optimize the phase start setting 
(configurable).

The ECG data of the spiral acquisition are 
stored together with the raw data to the local 
database. They are represented by a special 
image stamp in the Patient Browser.

Do not modify the patient (Edit > Correct in 
the Browser menu) after results have been 
calculated.  
This may result in inconsistent patient or 
image information.
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HeartView CT
Reconstruction

✧ Select a reconstruction job in the chronicle.

✧ Change the Phase Start on the Trigger sub-
task card to move the recon window to the 
required position.

✧ Define the further reconstruction parame-
ters where necessary and then start recon-
struction.

Reconstructing a Multiphase series

With multiphase it is possible to reconstruct 
up to 24 different heart phases within one 
recon job.

✧ Set the reconstruction parameters as 
desired on the Recon subtask card.

✧ Click on the Multiphase icon on the Trig-
ger subtask card.

The images are reconstructed and stored in 
one series.
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HeartView CT
When scanning with API, sequence scans are 
clustered and scan pauses are inserted corre-
spondingly. 

✧ Check the correct setting of the breathhold 
time in the Patient Model Dialog.

If necessary, you can modify the parameters 
of the sequence after a control scan and check 
them with a second control scan.
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HeartView CT
ECG Triggered Sequence

Setting scan parameters

✧ On the Routine and Scan subtask card, 
check the scan parameters preset in the 
scan protocol and change them if neces-
sary. 
 
 

Setting trigger parameters

✧ For examinations with contrast agents in 
particular, activate Synthetic Sync.

✧ Select ms (absolute delay) or % (relative 
delay) as the trigger unit in the selection 
box on the Trigger card. 

✧ Set the scan delay in the spin box in the 
Phase Start field. 
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HeartView CT
For the control scan, the scan and trigger 
parameters of the following sequence scan 
are acquired.

If necessary, you can modify the parameters 
of the sequence afterwards and check them 
with a second control scan.

After you have started the scan, the scanned 
scan windows are marked with pink lines.  
It is then no longer possible to change the 
trigger delay time.

The ECG data of the spiral acquisition is stored 
together with the raw data to the local data-
base. 
This is represented by a special image stamp 
in the Patient Browser.
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HeartView CT
Acquiring a control scan

✧ Perform a control scan to check the scan 
and trigger parameters.

 
 
 
 

Acquiring the sequence

✧ Perform the sequence and subsequent 
reconstructions in the usual way.
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Respiratory Gating

It is strongly recommended to see the opera-
tor manual of your Respiratory Gating sys-
tem for further information on acquiring 
scans with the respiratory gating, or respira-
tory triggering function.
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Respiratory Gating
Overview

The Respiratory Gating system is used in 
combination with your CT system in order to 
display artifact-free CT acquisitions of the tho-
rax region.

For this purpose a respiratory triggering as 
well as a respiratory gating function are pro-
vided. However, both functions are not oper-
able simultaneously. 

Respiratory Gating provides an open inter-
face mode which supports an external device 
to acquire the breathing signal, e.g. VARIAN 
RPM.

Respiratory Gating also provides respiration 
correlated scans for improvements in radia-
tion therapy planning. These scans enable 
you to delimit tumor contours and to reduce 
the radiation dose in therapy considerably.
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Respiratory Gating
For clinical application information and sug-
gested scan protocols see Application 
Guides.

It is strongly recommended to see the opera-
tor manual of your Respiratory Gating System 
for further information.
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Respiratory Gating
Preparations

In addition to the usual preparations in the 
examination room and on the console, some 
actions specific to Respiratory Gating are 
required.

 

✧ Position the patient on the patient table 
and immobilize the patient using the posi-
tioning accessories, if necessary.
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Respiratory Gating
If you register the patient for a Respiratory 
Gating examination and the integrated Respi-
ratory Gating system has not been connected 
properly, a corresponding dialog box is dis-
played.

✧ In case of using the integrated Respiratory 
Gating system please check the connec-
tion to the gantry and press Try Again. 

✧ In case of using the Open Interface please 
press Continue. 

Please be aware that the respiratory curve will 
then not be displayed on the Trigger card and 
the corresponding respiratory file from the 
external device has to be imported manually 
after the scan is finished.

For scans with contrast agent you should 
always activate the Synthetic Sync. so that a 
scan will not have to be stopped if problems 
arise with the respiration signal.

→ Page 139, Setting gating parameters
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Respiratory Gating
✧ In case of using the integrated Respiratory 
Gating system, apply the respiration belt 
with the pressure sensor and connect the 
cable to the measuring device.

✧ Select the required Resp. Gating scan pro-
tocol in the Patient Model Dialog and reg-
ister the patient for examination. 

✧ Scan a topogram and define the ranges for 
the spiral.
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Respiratory Gating
  

The Scan time, the Pitch, and the rotation 
time on the Scan subtask card cannot be 
modified.

You determine the time slice to be recon-
structed proportional to inspiration and expi-
ration.
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Respiratory Gating
Respiratory Gated Spiral

Setting scan parameters

✧ On the Routine and the Scan subtask card, 
check the scan parameters preset in the 
scan protocol and change them if neces-
sary.

Setting gating parameters

✧ For examinations with contrast agents in 
particular, activate Synthetic Sync.

✧ Select % In (inspiration) or % Ex (expira-
tion) or %Pi (for open interface) in the 
selection list on the Trigger card. 

✧ Set the percentage of inspiration or expira-
tion in the spin box in the Phase Start 
field.
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Respiratory Gating
Adjusting the respiratory curve is not apossi-
ble for open interface mode.

Additionally to an automatic mechanism 
(default) you can adjust the respiratory curve 
manually before the examination.

The manual curve adjustment (adjusting off-
set and gain of the respiratory signal) is only 
available when using the integrated Respira-
tory Gating device but it is not available when 
using the open interface mode.
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Respiratory Gating
Adjusting the respiratory curve manually

✧ Select the Trigger subtask card.

✧ Click on the Curve Setup icon on the Trig-
ger subtask card.

The Gain and the Offset sliders are displayed.

✧ Move the Gain slider to modify the curve’s 
amplitude.

✧ Move the Offset slider to shift the entire 
curve along the y-axis until the requested 
value and the respective position is 
reached.
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Respiratory Gating
 

On the right of the Trigger subtask card you 
can preview the changes made with the slid-
ers.

By using the CARE Bolus option you can syn-
chronize a respiratory gated spiral with appli-
cation of the contrast agent.

Control scan is recommended to check the set 
scan parameters of the spiral. 

In case you decided not to use the integrated 
Respiratory Gating device but the open inter-
face supporting an external device, e.g. 
VARIAN RPM.

A text will be shown on the Trigger subtask 
card to remind you that the open interface is 
activated.

The open interface only supports the data for-
mat of VARIAN RPM. 
When importing the respiratory file from an 
external device the system will convert the 
data into an internal format.

The breathing signal given by VARIAN con-
tains both amplitude and phase information.
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Respiratory Gating
Acquiring the spiral

✧ Perform the spiral acquisition in the usual 
way.

Using Open Interface 
Mode

✧ Connect the VARIAN to the CT system.

✧ Start and complete the scan without the 
breathing curve. (During the acquisition 
the breathing curve will not be displayed).

✧ Click on the Import icon on the Trigger 
subtask card.

The breathing curve will be shown on the 
Trigger subtask card after a successful 
import. If the curve is not shown please check 
that the data format is correct (VARIAN RPM).
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Respiratory Gating
 
The respiratory curve now contains a scroll 
bar via which you can call up the respiratory 
progression. In that way you can adopt the 
position of the scan window for the entire spi-
ral acquisition. (X-ray on is marked in 
magenta.)

If the respiratory curve has been edited (mov-
ing the sync points, inserting, disabling, delet-
ing missing or redundant sync points), you 
can switch between the original and the mod-
ified respiratory signal by activating Original 
RESP.

The respiratory data of the spiral acquisition is 
stored together with the raw data in the local 
database.  
This is represented by a special image stamp 
in the Patient Browser.

For amplitude-based reconstruction the fol-
lowing convention is valid:  
0% of Inspiration corresponds to 100% of 
Expiration (0 % In = 100% Ex), and vice versa 
100% of Inspiration corresponds to 0% of 
Expiration (100 % In = 0% Ex).
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Respiratory Gating
Reconstruction

✧ Select a reconstruction job in the chronicle.

✧ If necessary, edit the signal using 
the entries of the popup menu.

✧ Select the required reconstruction mode 
from the popup menu, either amplitude-
based (% In, % Ex - recommended for inte-
grated Respiratory Device) or phase-based 
(% Pi - recommended for external respira-
tory devices, e.g. VARIAN RPM; only avail-
able in open interface mode)

Change the Phase Start value on the Trigger 
subtask card to define the desired position of 
the recon window.

✧ Define further reconstruction parameters 
where necessary and then start recon-
struction.
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Respiratory Gating
It is strongly recommended to see the opera-
tor manual of your Respiratory Gating Sys-
tem for further information.

The scan time defines the single length of a 
scan. The total length of the sequence 
depends on the respiration rate. The more 
irregular the respiration rate, the longer rate, 
the longer the sequence scanning will take.

Therefore the recon begin and recon end can-
not be changed.
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Respiratory Gating
Respiratory Triggered 
Sequence

In contrast to Respiratory Gating, with 
Respiratory Triggering you:

✧ First define the patient’s respiratory phase 
using the laptop connected to the respira-
tory device in the examination room.

You start the sequence CT measurement via 
the console of your CT as usual.

✧ To set the number of scans and the number 
of images, select the required respiratory 
triggering protocol in the dialog box 
Patient Model Dialog and register the 
patient for the examination.

✧ Scan the topogram and define the range 
for the sequence.

✧ Start the sequence scan.

The image data corresponding to the defined 
respiratory phase are recorded. 

Additional Reconstruction

You can repeat the image reconstruction with 
different recon parameters. For respiratory-
triggered sequences, always the whole range 
is reconstructed. 
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Bolus Tracking
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Bolus Tracking
Overview

Many spiral CT examinations are performed 
with intravenous (i.v.) injection of contrast 
medium (CM). 

For all contrast examinations, exact timing of 
the CT scan is essential, that is, the scan must 
be performed when the organ or vessel of 
interest has the optimal contrast enhance-
ment.

Bolus Tracking monitors the flow of CM in 
the vessel and triggers the scan at optimal 
timing (CARE Bolus). It does not require an 
additional injection of CM but uses the bolus 
injected for the diagnostic spiral scan. 
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Bolus Tracking
 

 

  

 
 
 
 

For clinical application information and sug-
gested scan protocols see Application 
Guides.

The scan parameters of the spiral are used to 
determine the parameter settings of the pre-
monitoring and monitoring scan.

You can only activate Bolus Tracking if the 
scan that you have selected is to be acquired 
in the spiral mode and has not yet been mea-
sured.
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Bolus Tracking
Prerequisites

Bolus Tracking is integrated in the course of 
examination with the CT scanner. Before you 
activate BolusTracking for the ensuing spiral 
you should perform the following steps.

❏ Select a spiral protocol for examination

❏ Scan a topogram

❏ Plan examination ranges

Activating Bolus Tracking

✧ Select the spiral that you want to scan with 
Bolus Tracking in the chronicle.

✧ Select Insert > Bolus Tracking in the main 
menu.

All the examination steps required for Bolus 
Tracking are displayed in the chronicle:

(1) Pre-monitoring scan

(2) Contrast medium pause (I.V. Bolus)

(3) Monitoring scan

(4) Spiral for imaging
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Bolus Tracking
A Pre-monitoring scan is always acquired 
using sequence mode and without contrast 
medium.
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Bolus Tracking
Pre-monitoring Scan

✧ Select the Pre-monitoring scan in the 
chronicle.

Setting the scan parameters

All the parameters of the Pre-monitoring scan 
are displayed on the Routine subtask card.

✧ Check and adapt the mAs values if neces-
sary.

✧ Define the starting position and the FoV in 
the topogram.

 
 

Initiating scanning

✧ Confirm the parameters of the Pre-moni-
toring scan with Load.

✧ Move the table.

✧ Press the Start key on the control box.
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Bolus Tracking
 

On very small structures you can zoom the 
pre-monitoring scan to make it easier to draw 
in the ROI.

The information entered is stored with the 
scan protocol at the end of the examination.

If you insert Bolus Tracking into a scan proto-
col subsequently, all contrast medium values 
are reset to 0.

With the Auto trigger mode activated the spi-
ral scan is initiated automatically after reach-
ing the trigger level selected as default.
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Bolus Tracking
Preparing Monitoring 
Scan and Spiral

The pre-monitoring scan is displayed in the 
tomo segment. I.V. Bolus is now selected in 
the chronicle.

Defining the trigger ROI

✧ Position the cursor into the center of the 
trigger area and then press the left mouse 
button.

✧ Click into the ROI keeping the left 
mouse button pressed and move 
the ROI to the required position.

✧ Click on the outline of the ROI and, 
keeping the left mouse button 
pressed, move it out (larger) or in 
(smaller).

✧ Click on the Accept button to confirm the 
previously defined ROI.

✧ After that an Examination Overview pops 
up which has to be confirmed with OK.

Defining the I.V. Bolus parameters

✧ Check and correct the contrast medium 
parameters on the Routine subtask card, if 
necessary.

✧ Set the trigger threshold value using the 
spin box.
155

 



Bolus Tracking
 

You can also set Quick rotation instead of Full 
rotation on the Scan card to reduce scan time.

The maximum duration of the monitoring 
phase (cycle time and no. of scans) must be 
chosen such that it is certain that the contrast 
medium phase will be reached.

The shorter the cycle time, the more precisely 
arrival time of the bolus (trigger threshold 
value) can be defined. However, in that case 
correspondingly more monitoring scans are 
acquired.

If you have reduced the size of the FoV for the 
monitoring scan, you can now increase it 
again for the spiral scan or create an overview 
image and adapt the FoV in it.
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Bolus Tracking
Scan parameters for monitoring scan

✧ Select the monitoring entry in the chroni-
cle.

✧ On the Scan subtask card, check and adapt 
the following scan parameters, if neces-
sary:

❏ mAs value 
A relatively low mAs dose is sufficient for 
this step. 

❏ Number of scans 
If necessary, you can alter the number of 
monitoring scans with the No. of scans 
spin button. (Currently, the maximum 
number of scans is 50.) 

❏ Delay 
The time delay between pressing the Start 
button and triggering the first monitoring 
scan must be coordinated with contrast 
medium flow-in. The value you set 
depends on the physical condition of the 
patient. 

✧ On the Scan card, change the cycle time if 
you want to increase or decrease the inter-
vals between individual scans. 
 
 
 
 

Scan parameters of the spiral

✧ Select the spiral in the chronicle and check 
the range and the parameter settings.
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Bolus Tracking
You can also start the spiral manu-
ally with the Start Spiral button or 
with the Start key on the control 
box.
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Bolus Tracking
Starting Bolus Tracking

Simultaneously start contrast medium admin-
istration via the injector and the monitoring 
scan with the Start key or the foot switch.

Monitoring scan

After the specified delay time, the system 
starts the monitoring scan.

✧ Check the time-density curve of the con-
trast enhancement on the Trigger card.

Starting the spiral

As soon as the set threshold value within the 
ROI is reached, the spiral scan is automatically 
started.

Ending Bolus Tracking

When the spiral is complete, the data is saved 
to the local database. 

✧ You can reconstruct the images of the 
examination from the raw data of the spi-
ral.

✧ You can now view, evaluate, and docu-
ment the reconstructed spiral images.
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Bolus Tracking
On the Trigger subtask card, you can easily 
see at which time a certain HU value is 
reached. 
✧ Position the cursor at the point you are 

interested in and the HU value at this time 
is shown.
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Bolus Tracking
Performing Test Bolus

Test Bolus is another method of contrast 
examination, an alternative for the Bolus 
Tracking method.

✧ Right-click and choose Bolus 
Tracking to insert the steps into 
the Chronicle.

✧ Right-click the spiral scan step and 
insert a Contrast pause. 

✧ Plan the ranges and enter the CM details 
on the Routine subtask card.

✧ Start the power injector with the test bolus 
and start scanning the bolus tracking 
range.

✧ Use the time for the peak enhancement to 
calculate the spiral start delay. Enter it as 
the start Delay time on the Routine sub-
task card for the actual CM examination.
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CARE Vision CT
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CARE Vision CT
Overview

CARE Vision CT is a special examination scan 
mode for interventions like biopsies or drain-
ages under CT control.

Images are continuously reconstructed and 
displayed on a monitor inside the examina-
tion room, so that the examining physician 
can monitor the movement of the surgical 
instrument to avoid injuries of sensitive struc-
tures like vessels or nerves.

CARE Vision CT offers the special operation 
mode HandCARE: Radiation is interrupted for 
a very short time, whenever the tube is in the 
set position. This way, for example, the exam-
ining physician’s hand is protected from direct 
radiation. Otherwise scanning is done with 
continuous radiation.
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CARE Vision CT
  

For clinical application information and sug-
gested scan protocols see Application 
Guides.

The following aspects in CARE Vision CT 
examinations must be taken into account:

❏ The scan is always acquired at the current 
table position with minimum start delay.

❏ The horizontal and vertical table position 
and gantry tilt can be freely selected within 
the collision limits.

❏ You must always trigger the scan with the 
foot switch. Once the scan has started, no 
automatic table feed occurs.

❏ The rotation time (lowest value), slice 
thickness mode (narrow collimation), and 
table feed per scan (0) are preset and can-
not be changed.

❏ The raw data of the CARE Vision CT scans 
is not stored. Subsequent reconstructions 
are therefore not possible.
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CARE Vision CT
Preparing CARE Vision CT

You activate CARE Vision CT by selecting the 
corresponding scan protocol from the "Spe-
cials" section in the Patient Model Dialog.

Initial scans

✧ Scan a topogram and define the examina-
tion ranges.

✧ If necessary, locate the structure to be 
accessed with a spiral scan.
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CARE Vision CT
 
 
 
 
 
 
 
 

You can click the Move Table Top 
Only (formerly known as ICT Mode) 
icon to only move the table top. This 
provides more space between the table base 
and the gantry during an interventional pro-
cedure.
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CARE Vision CT
Setting the Parameters

✧ Click the desired protocol step in the 
Chronicle.

The watermark image on the right-hand side 
of the Routine subtask card indicates the scan 
type and whether HandCARE is activated.

Settings on the Routine card

Here you specify the step length that the table 
must travel when you jog it by tapping the 
joystick and/or the symbol keys on the gantry 
operating console.

✧ Select Continuous in the Movement 
selection list if the table is to move by 
0.5 mm on every "tap".

Or

✧ Select Incremental and enter your own 
step length in the input field (the mini-
mum incremental distance is 0.5mm).

✧ Set the tube voltage, the mAs value, the 
slice thickness and make further required 
settings for your CARE Vision CT scans.
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CARE Vision CT
The values in the HandCARE selection list are 
correct only for a standard clock assumed on 
the front of the gantry cover.
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CARE Vision CT
Settings on the Scan card

Here you can choose between continuous 
radiation and radiation with pauses (Hand-
CARE).

✧ Choose the required tube position (10, 12, 
2 o’clock) from the HandCARE selection 
list to set scanning with interrupted radia-
tion.

Or

✧ Choose None from the HandCARE selec-
tion list to deselect HandCARE and to scan 
with continuous radiation.

 

Settings on the Recon card

Here you check and, if necessary, correct the 
window settings and parameters for the 
image settings.

✧ Select a window that is suitable for the 
type of tissue to be reconstructed.
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CARE Vision CT
              

The two sub-images are displayed either as 
small or equal sized images in the lower left 
and right corner.

CARE View mode is on if the number of slice 
positions per scan is three.
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CARE Vision CT
Displaying images in CARE View mode 

The display of the CARE View mode depends 
on your selection on the intervention toolbar.

(1) CARE View blow up mode: Two sub-
images representing the neighboring 
positions before and after the slice posi-
tion of the center image

(2) CARE View mode: The same alignment 
with three images of the same size
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CARE Vision CT
 
 
 

     

While CARE Vision is active, CD or DVD burn-
ing is not possible because of examination 
related requirements.

When you have loaded the scan protocol and 
before all further scans, the start prompt is 
displayed.

It is possible to tilt the gantry between scans.

If the HandCARE option is checked on the 
Scan subtask card, all acquired images are 
stored. Otherwise 1, 2 or 4 images per second 
are stored depending on your configuration.

With a double click into the tomo segment 
you can toggle between Blow Up mode and 
standard layout.

For technical reasons, it is not recommented 
to use the Camtasia recording tool to record 
desktop activities.
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CARE Vision CT
Performing CARE Vision CT

Once you have defined the scan and recon-
struction parameters, switch the scanner 
ready to scan.

✧ Confirm the scan protocol with Load. 
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CARE Vision CT
The intervention toolbar is also available for 
Biopsy with different display modes.

The Blow Up icon will be dimmed when CARE 
View mode is on, while the CARE View and 
CARE View Blow Up icons will be dimmed 
when CARE View mode is off.
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CARE Vision CT
Using the Intervention Toolbar

✧ Choose the required icon from the inter-
vention toolbar on the Examination or on 
the Recon task card.

✧ Click on the Interventional Windows 1/2/
3 icon to modify the windowing value of 
the currently displayed images. 

✧ Click on the Save Current Table Position 
icon to save the set table position.

✧ Click on the Auto Stop at Saved Table 
Position icon to make the table automati-
cally stop at the saved table position 
defined by you.

✧ Click on the Auto Stop at Last Interven-
tional Scan Position icon to make the 
table automatically stop at the last scan’s 
end position.

✧ Click on the Blow Up icon to display images 
in the blow up mode (one image has the 
size of the complete image area).

✧ Click on the CARE View icon to display 
images in the CARE View mode (3 seg-
ments have the same size).

✧ Click on the CARE View Blow Up icon to 
display images in the CARE View blow up 
mode (one main image in the center and 
two small images in the lower left and 
right corner).
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CARE Vision CT
The scale bar is not displayed if it interferes 
with the text block containing the window 
values for the large size display.
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CARE Vision CT
Controlling the scanner

✧ Press the foot switch continuously to per-
form a scan.

✧ Press the foot switch again to start the next 
scan.

✧ Use the joystick or the keys on the gantry to 
move the table horizontally in the scan 
pauses.

Tomogram display

The acquired tomograms are displayed in 
Blow Up mode automatically on the screens in 
the control room and in the examination 
room.

Information about the radiation dose and 
scan time is given in the top right-hand area 
of the Examination card.

(1) Scan time in seconds 

(2) Radiation dose in milligray
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CARE Vision CT
With End Exam the display for the entire radi-
ation dose is reset; it starts from the begin-
ning again on the next examination.

This also applies if you perform a subsequent 
examination on the same patient.
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CARE Vision CT
Ending CARE Vision CT 

Once you have completed the last scan 
required for the intervention you close 
CARE Vision CT mode.

✧ Click on the Cancel button on the right-
hand side of the Examination card to 
deactivate the system’s readiness to scan.

✧ Continue with the next scan listed in the 
chronicle or close the examination with 
the Close current patient icon.
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CARE Vision CT
Only the original Siemens x-ray foot switch 
must be installed.
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CARE Vision CT
Accessories for 
CARE Vision CT 

(1) Foot switch for triggering scans 
The scan is triggered as soon as you press 
the foot switch and keep it pressed.

(2) Foot switch for table height 
You can use the foot switch to move the 
patient table vertically during scan 
pauses.

(3) Joystick 
You can move the table top horizontally 
with the joystick mounted on the patient 
table.

(4) Monitor 
You can monitor surgical intervention 
during the scan at the monitor (ceiling 
stand or trolley) in the examination room.
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